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Linux Mint - Cinnamon 
Install, Setup and Tips 

 

About This Document 

This document outlines the eight steps to install and setup the Linux 

Mint Cinnamon Operating System, on laptops used in the Missoula 

Public Library, Makerspace. Tips are also included throughout the 

document.  Instructions for installing and using Linux Mint can be 

implemented by anyone for their own PC. 

 

These instructions were written to replace the Windows 10 

operating system on Dell Latitude laptops used in the 

Missoula Publick Library - Makerspace. 
 

✓ Makerspace Laptop model: Dell Latitude 7480  

✓ Dell Latitude 7480 boot-up function keys:  

o UEFI Setup = F2  

o USB Boot Menu = F12  
 

 

Updates to this document can be found at this website:  

https://sites.google.com/view/htt-helpful-tech-tips  

Log in with your Google account, then select the Linux User Group link.  

  

Date: 09/8/2025 

Dan Hubing    Email: parlors.grazer.4r@icloud.com  

https://sites.google.com/view/htt-helpful-tech-tips
mailto:parlors.grazer.4r@icloud.com
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1) Backup your files – before installing Mint 

Use an external USB drive or a USB Flash drive; copy over all your information 

you want to keep.  

You can use a cloud service instead of an external drive; but your cloud service may 

be too complex to connect to later in Linux Mint.  Using an external drive will ensure 

an immediate safe location, with easy access.  Large external hard drives are 

available from many electronic stores.  This may be a good time to go and purchase 

one. 

 Photos, videos, and music files (Now’s a good time to clean these up!       )  

 Documents, spreadsheets, any work or personal files 

 Using your browser export your Favorites, Bookmarks and Passwords to the 

external drive. Later you can import them. 

 Email addresses and passwords. If you use Outlook, export PST files if needed. 

 Are your Passwords in a password manager program?  You should do an 

internet search to ensure that there is a Linux version of the Manager program  

 Open the Documents folder. Copy over “everything” that you want to keep.  

Don’t make the mistake, like I did, by just dragging the Documents folder to your 

USB drive; you’re probably just creating a shortcut. You need the contents, so 

make a new folder on your external drive and then drag over the contents of the 

Documents into your new folder.   

 Open the Downloads folder to see if anything is there that you may need. 

 App list, so you see anything that you must have later in Linux Mint?  To see the 

list of apps; open Start > Settings > Apps.  Many Windows apps have 

alternatives in Linux.  Make sure you save any documents or information from 

these Windows apps. 

 Any unique hardware drivers you are using?  Things like Network adapters, 

Graphics cards or Printers/Scanners. 

 BitLocker Recovery Key: If BitLocker encryption is enabled you may need the 

key to access the drive later.   

▪ Visit: https://account.microsoft.com/devices/recoverykey  

▪ Login with your Microsoft account to retrieve and save the key. 

 Here’s a good trick. Take photos, using a camera, of your Desktop or File Explorer 

structure.  Then you can recreate that in Mint File app after the installation. 

 In a text file, type in any notes,  any setting changes, options or preferences that 

you want to duplicate, or any comments that you might want to remember. 

 

  

https://account.microsoft.com/devices/recoverykey
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Obtain Windows 10 Key before Mint Installation 
 

The Microsoft Windows 10 product key is a 25-character alphanumeric code used to 

activate and verify a genuine copy of Windows.   

 

Obtain the Key, if Windows was preinstalled when the computer was purchased: 

1. Right-click on the Windows Start icon in the Taskbar 

2. Open Windows PowerShell as Administrator (It may say Terminal (Admin)) 

3. Type in or copy this command:  

(Get-WmiObject -query 'select * from SoftwareLicensingService').OA3xOriginalProductKey  

4. It will return the 25-character alphanumeric Key sequence:  

xxxxx-xxxxx-xxxxx-xxxxx-xxxxx 

5. Copy and save the key sequence on your USB device.  That way if you ever go 

back to Windows 10 on that PC, you have the key.  (You might want to note the 

key value in the “Reinstalling Windows 10” Appendix section.) 

 

Obtain the Key, if Windows was a retail purchase: 

1. It was printed on a card or the box label.  It might have been emailed to you. 

2. It might also be known as a “digital entitlement”. 

 

Final thoughts before continuing with the Mint installation: 
Stop here a minute and really understand that your computer will be rebuilt from the 

ground up – just not with Windows, but a whole new operating system; Linux Mint 

Cinnamon version. 

 

Give yourself some time to look over your Windows 10 computer again, to see if you 

need to add any information to your “To Do Later” list. 
 

One thing you need to know is what the UEFI Setup and USB Boot Menu keys are 

for your computer make and model.  This should be a simple internet search. 

Make ___________  Model _____________ UEFI Setup ___ USB Boot Menu ___ 

• Later, after the installation, you can move these files into the new Mint system.   

• When you have everything off your computer, it’s time to get down to business 
and jump into installing Linux Mint. 

Once you are comfortable that you have everything off the Windows 

PC, you may continue with installing Linux Mint.  
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2) Install Linux Mint: Cinnamon Edition 

Once you are confident you have all your files off the computer and know what apps 

you need to add after the installation, you may continue. 

 

Tip: Setup a second computer or tablet as a 2nd computer, with this PDF file on it.  

Then you will have an easier access to the internet, when questions or problems 

arise during your installation.  (The library has laptops you can use.) 

Make sure you know what Function keys for the EUFI Setup and USB Boot Menu 

for your specific computer.  You need these to continue with the installation of Mint. 
 

1. Launch a web browser on the Windows 10 computer 
 

2. Download Linux Mint’s Cinnamon edition: 

➢ Go to: https://Linuxmint.com/download.php (or search for Linux Mint Download)  

There are two possible versions of Linux Mint.  If you have at least 4 Gb of ram, 

which most PCs do, then you’ll download Cinnamon.  If your PC has 2Gb of RAM, 

then you should download the lighter version; Xfce. 

➢ Click on the Download button for the Cinnamon Edition,  then scroll 

down and click on one of the USA locations, like Harvard School of 

Engineering. 

➢ This downloads the linuxmint*.iso file into your Downloads folder 
 

3. Create a bootable USB drive for the new LinuxMint ISO file 

➢ Insert a USB flash drive. 

➢ the Rufus app, which runs on your Windows computer, is used to create a 

bootable USB drive that contains the Mint ISO file.  
 

1) Go to https://rufus.ie  (Don’t click on any Ads, there are lots of them!) 

2) Scroll down and select the latest rufus*.exe Standard for Windows link. 

3) In the Downloads folder, double-click on rufus*.exe 

4) Drive Properties: 

a. Device = select your USB flash drive 

b. Click Select button to select the *.iso file in Downloads. 

Leave all other options at the default value. 

c. Select Start to begin (select Yes if a Download required dialog 

box opens.)  This can take 15 minutes or so. 

d. It will finish when the Status bar shows READY. 

e. Keep the USB stick in the computer.  You’ll be directed to 
remove it later. 

 

4. Boot into “UEFI Setup” to disable Secure Boot  (F2 on Dell Latitude 7480) 

(Note: UEFI is the firmware on your computer’s internal mother board.) 

Linux Mint may not be installed properly with secure boot enabled. 

https://linuxmint.com/download.php
https://rufus.ie/
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It should be disabled in UEFI prior to installing Linux Mint iso file 

➢ Restart the PC, go into EUFI and locate the Secure Boot option. 

Then disable Secure Boot.  To save this change, when you Exit, it 

should ask if you want to save any changes; select yes. 
 

5. Boot into “USB Boot Menu” to load Mint. (F12 on Dell Latitude 7480) 

➢ Restart the PC. In a few seconds the Dell icon is displayed, depress F12 

 

(On the Library’s Dell PCs, the F12 is depressed repeatedly when the Dell 

icon is displayed. Refer to the information gathered from the previous 

page for your specific computer.) 

 

➢ Select the name of your USB Flash drive device 

➢ Select “Start Linux Mint…” the top of the list of options. 
 

➢ When it is launched, look for a desktop icon that says Install Linux Mint.  

Double-click on it.  Select the options that fit your installation.  Then click 

Continue. 

• When the “Installation Type” window opens, select Erase disk and 
install Linux Mint.   

• When the “Network connection type” window opens, select the type 
you will be using, usually WiFi, then your network name and password  

 

➢ Continue with the initial information. 

i. Where are you? Time zone, click in Denver (Mountain time zone) 

ii. Who are you?  (You may use different names on your personal system) 

1. Your name: makerspace 

2. Username: Makerspace (Admin username – no spaces) 

3. Password = Mspace77 (Admin password – 8 characters) 

(Note: You can always change the password information later by going to:  System 

Settings > User and Groups.  Write down your admin name & password.) 

iii. Installation begins.  When directed, remove the USB drive. 

 

6. Successful - Launch Linux Mint for the first time: 

➢ When complete, select Restart now. 

➢ Log in with the Makerspace administrator username and password 

➢ The Welcome screen will launch.  Continue to next step. 
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3) Recommended Mint configuration options 

The initial Welcome to Linux Mint Welcome window is an easy way to configure Mint. You 

can uncheck the “Show this dialog at startup” checkbox.  Then, select the “Let’s go!” button.  
 

In the First Steps button, you will set up the initial configuration of Linux Mint.  (There 

is a Welcome Screen app, that is the same as the Welcome to Mint program, it’s 
available for future changes.)  The configuration settings here are for the 

Makerspace’s public  computers—your own personal computer may have different 

settings. 

 

Welcome Screen recommended configuration changes: 

Select Let’s Go to get started setting up Mint. (Click the Launch button for each section) 

Desktop Colors – (This edits the Theme displayed by the Desktop) 

1. In Style: select Mint-L  

2. In Appearance: select Light 

3. In Color: select the gray colored ball. 

Notice there is no “save” or “close” buttons, like are in Windows.  So just select the x 

in the top right-hand corner.  

System Snapshots – (These are snapshots of current Mint configuration.) 

1. Snapshots require Administrator rights, so log in with your Admin pw. 

2. Select Create to create a current Timeshift snapshot. 

3. Select Settings > Schedule; None for the Library. (Twice monthly for home use.) 

Driver Manager – this app checks for driver updates, select any that are needed. 

Update Manager – Select Install Updates when they exist.  You will need to log in 

with your Admin pw.  This app manages system packages, Standard 

Package (APT) installed apps, and security patches.  More information is 

found in the section “7) Updating the software” in this document.   

 

System Settings recommended configuration changes: 

Appearance section: 

1. Backgrounds: In the Wilma group, select Ocean. 

Notice: To return to the System Settings window, select the “left arrowhead” icon 

2. Font Selection: First, change 10 to 12 for Fonts selections, except 

make the Window title font 14..  Then, in the Font Settings section, 

change the Text scaling factor to 1.2 and the Hinting set to Full.  

Preferences section: 

3. Accessibility: First, in the Visual tab, turn On the Enable Zoom and 

then in the Mouse tab wheel modifier option: select, <Control>. (You 

can not zoom by scrolling your mouse wheel.)  
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Second, in the keyboard tab, turn on the “visual indicator for Caps & 
Num Lock”. 

4. Date & Time: Turn Off the Use 24h clock  

5. Desktop: Turn on; Home, Trash and Mounted Drives 

6. Panel: In Panel height, slide to 50.  In the Panel Appearance section, 

make sure the Left Zone (this controls the left-side icons of the Panel) 

is selected and change the Colorized icon size to “Scale to panel size 
exactly”.  Then select the Right Zone tab (this controls the right-side 

icons on the Panel) and change the Symbolic icon size to 30. 

7. Windows: Behavior tab, in Draggable border width: slide to halfway. 

Hardware section: 

1. Mouse and Touchpad: Mouse tab: slide the Pointer size to ¾ of scale 

2. Power Management: 

a) Power tab: In the When lid is closed: set “both” to Shut Down Immediately  

b) Brightness tab: set Dim screen after inactive: to 10 minutes  

3. System Info:  

a) Operating System: displays installed version of Linux and Mint 

b) Upload system information = This opens a browser window with 

“full details” of this Linux Mint installation 

Administrative section: 

a. Firewall: Since these computers will be on the Missoula’s Library public WiFi 

network, change the Profile from Home to Public, slide the Status to On. (To 

edit the Firewall for your personal use, you’ll have to do your own research.  
It’s beyond the scope of this document.) 

b. Login Window: In the Users tab, you can select one of your users to 

automatically login.  The delay option will give you time to choose a 

different user instead of the auto-login user; 10 seconds should be good. 

Close the System Settings app by clicking the top-right corner X. 

 

Miscellaneous configuration changes 

 Click on the “Menu” icon in the Panel (Note: The Panel is Mint’s Taskbar) 

 

The Menu window can be resized by dragging the edges to the size you want.  For 

more information on the Menu, refer to the Appendix, Tips for using Mint, section of 

this document. 

1. Search for Software Manager; then rt-click on the Software Manager 

app, then select Add to panel.  This will add the Software Manager 

program icon to the Panel. 

2. Search for LibreOffice Writer; then rt-click on the LibreOffice Writer 

app, then select Add to panel.  

(LibreOffice is a free Microsoft Office equivalent and easily works with 

Microsoft Office files.) The following steps will modify LibreOffice Writer 

to appear like Microsoft Word. 
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o Launch LibreOffice Writer. 

o Uncheck the “Show tips on startup” checkbox 

o Under the View tab, select User Interface: select Tabbed, then 

Apply to All, then close. 

Click in the top-right-hand corner’s “empty box” or the box with 

the“3-line hamburger icon inside”; whichever is present.  

o Select Options: Then under the LibreOffice group, click View. In 

the Icon Theme, select Colibre (SVG) and change the Icon Size 

-  Tollbar: field to Extra Large, the Notebookbar: field to Large 

and the Sidebar: field to Large. Click OK to save.   

o Close LibreOffice Writer now. 

3. Right-click on Battery icon located on the right side of the Panel: 

▪ Select Configure; this loads the Power Manager window 

▪ Set Display to “Show percentage and time remaining” 

Firefox Browser Configuration: 

4. Firefox Web Browser is the default browser used by Linux Mint. 

Launch Firefox, skip any “Welcome to Firefox” windows.  Then make 

these changes. 

o Add the Malwarebytes Browser Guard extension.  This 

extension will check all websites for malware and viruses. 

o Go to www.Tinkercad.com, click the “star” in the address bar 
to Bookmark this page. 

o Go to https://www.thingiverse.com/ click the “star” in the address bar 
to Bookmark this page.   

Add this “optional” website can be added to the Bookmark Toolbar 

• Go to: www.Duckai.com, add this is a Bookmark Toolbar.  

This is a free AI chatbot that does not require a password. It’s provided 

by DuckDuckGo, which is a privacy focused internet company.  

Files Configuration: This is Mint’s file manager program.   
Launch Files (click on the “folder” icon in the Panel). 
Select the Edit menu option, then Preferences: 

o Views group: For Default View, change to List View 

o Behavior group: In Trash group, check Ask before moving files to the Trash 

o Preview group: For Tooltips, check all three Show … checkboxes 

<< NOTE: These configuration settings may need to be repeated for each new User added to your Mint system. >> 

http://www.tinkercad.com/
https://www.thingiverse.com/
http://www.duckai.com/
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4) Information on downloading & installing programs 

The location we’ve used for years to install programs in Microsoft Windows included 

the Microsoft Store or going to the program’s website and downloading an .EXE or 

.MSI file.  In the Linux world the downloading process is very similar.  For Linux Mint, 

the Software Manager app is the equivalent to the Microsoft Store.  In Mint’s Software 

Manager, you’ll select a “package type” to install the actual program.  If the program 

is not found in the Software Manager or if you want the later version, you can go to 

the program’s download website page.  There, you may see options to download a 

Linux version.  A few Linux file formats may be available; *.deb and *.AppImage, or 

even a Linuz zip file.    

 

Another download library of programs is available from Linux; known as “hub” 
websites.  For example, the latest Arduino program version is available from a very 

common hub, known as Flathub.   

 

Programs with the .deb extension are easy to install.  Simply download it.  Then 

double click on it to install it.  When the installation is done, you can send to delete 

the *.deb file, since the program code is installed in Mint. 

 

Programs with the .AppImage extension, when downloaded, will need to have its 

Properties tab edited to set it to “executable”. Then you should be able to double-click 

on it to “run” the program. (There is no installation, since the AppImage is the 
program, so you’ll have to keep the AppImage file on the computer. 

 

As you can see, programs available for Linux computers are downloaded and 

installed in a variety of ways. 

 

Using Mint’s Software Manager: 

Software Manager is Mint’s “app store”, where you can find and download many 

apps.  Tip: There is a Search button in the top left-hand corner to help find apps. 

 

Launch the Software Manager app from the Menu  

Open the Menu, launch the Software Manager, then search for your app you wish to 

install; but before you select the Install button; you should check out the “package 

type” button, located below the “Install” button.  Programs come within different 

packages, sometimes. This is where you can select which software package you will 

use for the downloading of the app. If only one package is present, just select Install; 

but if there are more than one available, then select each and note the program’s 

version number.   

 

If you select “System Package”, you are choosing the default “APT” package type.  

(APT stands for Advanced Package Tool, which uses a .deb system package file.)  
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The System Package APT may not have the latest version of the app you wish to 

download, you should check out Flatpak package option. 

 

If you select “Flatpak”, you are choosing this as your download package type. (You 

only see this if the app itself is available for download from the Flatpak software hub 

store. Usually, Flatpak offers a newer version of the app, so it’s normally the one to 

choose. To locate the app’s version number, select each download package button 

and then scroll down to locate the Version #.  Choose your download package, then 

select Install.   

 

If no Flatpak options are available – don’t worry! 
If for some reason you don’t see Flatpak as a download option; that means that the 

app is not available from the Flatpak repository, or store; which is known as Flathub.   

For more information on Flathub, check out their website: https://flathub.org.   

Flatpak – What is it? - This is a software package installer. It adds another installer 

option, besides the standard APT installer from Mint.  (Usually, you would choose the 

installer that has the latest “version” of the app.  To check, select the installer and 
then scroll down to see the version number of the app you are going to install.) 

Install by using this Terminal command: sudo apt install flatpak 

 

Can’t find your app in the Software Manager program?   
Then Use a browser to locate the download site for your program.   
 

  

https://flathub.org/
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5) Install 3’rd party programs 

The apps below are programs used in the Library’s Makerspace. Of course, for your own 

personal computers, your app selections may differ.  After these are installed, you may 

want to install the programs that you used in the previous Microsoft Windows system.  

Also, copy over any personal data files that you backed up prior to installing Linux Mint. 

 

To find programs, first use the Software Manager.  If they are not there, try their own 

website download page. 

➢ GIMP – from Software Manager (Photo editing software) 

1. From the Software Manager, search for GIMP.  (You will notice there are 

lots of selections to choose from - we only want the Gimp app.  If you’re 
still not sure what to choose; select one, then scroll down and select 

Homepage. That helps sometimes.) Install using the Flatpak package 

since it has the latest version.  Continue to accept the additional software. 

2. Search for GIMP in the Menu.  (Mint will sometimes place apps withing a 

specific category, in this case select the Graphics category or of course 

it’s under All Applications as well.)  Select GIMP to launch it. 

Tip: Notice the name of the program, it’s the long name for G.I.M.P.  You may 

want to right-click on it and select Properties to rename it to GIMP.  If you want 

to use this program often, you may want to add to Panel or Desktop. 

3. When you save a file from apps like this, they are usually saved 

under /home/<username>/<appname> 

 

➢ Google Chrome – (Google Chrome browser) 

Chrome is easily installed using the .deb file extension download file. 

1. From Firefox go to https://www.google.com/chrome/  

2. Select the Download Chrome button 

3. Select 64 bit .deb (For Debian / Ubuntu), then Accept and Install 

4. After the download, open the Downloads folder and double-click 

.deb.  Then click Install Package. Login with admin password. 

5. Open the Menu, in the Internet category is Chrome.  

(Note: some standard users may need to login with the admin 

password to open Chrome.   

 

➢ Inkscape – from Software Manager (Makerspace’s Laser cutter software) 

1. Download from the Software Manager using the Flatpak package since 

it has the latest version.  Continue to accept the additional software. 

2. Launch the app from the Menu.  Open File > Save As to identify the 

saved location. 

3. Create a Desktop shortcut.  In Menu, right-click on Inkscape and 

select Add to desktop 

https://www.google.com/chrome/
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➢ PrusaSlicer – from Software Manager (Makerspace’s 3D printer slicer) 

1. Download from the Software Manager, using the Flatpak package. 

2. Right-click on PrusaSlicer in the Menu.  Select Add to Desktop 

3. Launch the app from the Desktop. 

4. Tip: Launch PrusaSlicer and save a test file to identify the saved location. 

 

• Arduino – from the Arduino website. 

You will be downloading the Arduino “AppImage” file, set it to 

executable, then execute it to use Arduino.  The AppImage file is a 

package that is “self-executing”.  Once you change the execution setting, 

all you need to do is double-click to run the program. 

1. Go to https://www.arduino.cc/en/software/  

2. Before select the Download button, make sure you select Linux 

Applmage… option.  Then select “Download” from the next couple screens.   
3. The Arduino…..AppImage will download into the 

/home/<username>/Downloads folder. 

4. Open Files and go to the Home folder. (Tip: In Files; select View > 

Sidebar > Tree.) 

5. Since the AppImage is the actual program to execute, you should 

move it from the Downloads folder, into something like a /Programs 

folder.  Select File, display the <username> folder; then, under File 

menu select Create new Folder. Create a MyPrograms folder under 

the <username>.  (You could also right-click on the Files app to 

open the right-click menu, which as common commands.) 

6. Copy the Arduino…AppImage file from /Downloads to /MyPrograms. 

(Tip: an easy way to copy files is to have two File apps open.  So, under 

the File menu option, select New Window.  Move the two Files app 

around to make it easy to drag the AppImage from Downloads into 

MyPrograms. 

7. Now set the AppImage file to be executable.  Right click on the 

Applmage file and select Properties.   

8. In Properties, select the Permissions tab. 

9. In Permissions, check the Allow executing file as program. This 

will allow the program to run when double clicked. 

10. Close (lower right-hand corner) the Properties window  

11. In Files, double-click on the Arduino program.  It should launch. 

Note: since AppImage directly launch, they are not “installed” like 
*.deb or Flatpak packages.  . But unlike DEB or Flatpak installs, 

AppImage files don’t automatically integrate the main Menu.   

 

Here’s how to do Add the Arduino to the Menu. 

https://www.arduino.cc/en/software/
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1. Right-click on the Menu; select Edit menu. 

2. In the most left column are the Menu’s categories. Decide what 

category you want to put the app in; select the Programming 

category, since Arduino IDE is a programming tool. 

3. Select the New Item button.  The Launcher Properties dialog 

box opens.   

4. In the Name field; type in Arduino IDE 

5. In the Command field, select the Browse button and browse 

to the MyPrograms folder where the AppImage is located.  

Click on the Arduino…AppImage file and then select OK. 
6. Change the default Icon, by clicking on the icon.  Then in the 

Choose an icon window, search for Arduino and select one 

of the options. 

7. Finally, select OK in the Launcher Properties dialog box to 

save and close. 

8. Close the Main Menu editor window. 

9. Test out your new Menu entry.  It should be under the 

Programming category, and you should be able to search for it. 

10. You can right-click on it and add it to the Desktop, if you wish.   

When you do your first Upload to an Arduino board, it may not be listed , you may 

need to insert the Arduino AVR Boards library from the Boards Manager… 

1. Select Boards Manager… 

2. Search for Arduino UNO in the Boards Manager search field. 

3. Install Arduino AVR Boards 

If the Port selection is grayed out, then select Reload Board Data. 

1. In Ports, don’t select a port identified as /dev/tttSx 

2. Select a port that has USB in its name or ACM in its name. 

If for some reason you get a “Permission denied” compiler error. Here is a solution. 

You need to run the Terminal command:  sudo apt remove brltty.  

Don’t forget to hit Y for yes in Terminal. 

(This command will uninstall the BRLTTY software. The brltty app takes over 

control the COM ports; so, it needs to be removed.  Then Arduino can gain 

access to the COM ports.) 
 

If you get this Compiler Error about “access permissions”, then try this Terminal 
command:  sudo usermod -aG dialout $USER 

This command ensures the logged in user is added to the dialout (serial ports) group.  

Log out and then try another Upload to see if the compiler error occurs again. 
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6) Add a new User  

It’s always wise to have a “Standard” username for your daily work and an “Administrator” 
username for any system work.  Below are instructions for adding a Standard User. 

 

Add a standard user: 

1. Launch User and Groups. Login with your Administrator password. 

2. In the Users tab, select the Add button. 

3. Use this username information: 

Keep the Account Type as Standard. 

Full Name = User1, and Username = user1. Then click Add. 

The syntax rules: For Full Name is anything, but the Username 

are all lower-case letters, no spaces, numbers are ok. 

4. Select your new user1’s username, in the Users tab. 

a) There is No password set for User1 since the Library’s 
Makerspace has no password requirements. So, leave it as is.  

b) Select the Groups listed to open the Group List. 

c) Check to add these groups: dialout, makerspace (the admin 

username), and users 

d) Select OK and then close the User and Groups window. 

5. Select Menu, then in the left side column (known as Favorites), 

click on the “circle with line on right-side” icon.  That’s the Log Out 

button. Select the Switch User button and log in with “user1”. 
 

6. Configure the new user:  

The first time you log in with a new username the Welcome window 

opens.   

 

Refer to the section “3) Recommended Mint configurations 

options” in this document to make suggested changes for this new 

user as you did with the Admin user. 

Return here after you are done with that section. 

 

7. Configure apps for the new user: 

Create Desktop shortcuts for apps installed by Software Manager. 

a) In the Menu, search for PrusaSlicer. Right-click on it and 

select Add to desktop. 

b) In the Menu, search for Inkscape. Right-click on it and select 

Add to desktop. 

c) In the Menu, search for Arduino IDE. (If the Arduino app is 

not in the Menu you may need to follow the instructions for 
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adding Arduino to the Menu, from the install instructions 

above.) Right-click on it and select Add to desktop.   

 

Notice how easy it is to add these apps to the desktop.  That’s 
because they were installed using the Software Manager.  If you 

open the Properties of these apps (Right-click and select 

Properties), you will see the word “Flatpak” in the Command line.  
That means the app was installed using the Flatpak install package 

from the Software Manager. 

 

 
Note: Some Rules for executing apps by a standard user: 

• Users can run applications installed system-wide via the Software Manager (APT 

or Flatpak).  But they cannot modify or delete those system-wide apps; only the 

Admin password has those rights. 

• Users cannot run AppImage files stored in other users' home directories unless 

they are explicitly granted permission. 
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7) Updating software 

If updates to the Mint operation system including security and driver updates as well 

as 3’rd party apps, an “Update” notification icon is visible in the panel. (You can also 

launch the Update Manager app itself, to manually check for updates. Open the 

Menu and then search for Update Manager.)   

 

The type of update action depends on how an app was installed.  There are 

three common software app packages that are used in a Linux system: APT, Flatpak 

and AppImage. For System Package (APT) and Flatpak apps, the update is easy 

using Update Manager.  AppImage apps are more complex, requiring manual 

installation and manual updating. 
 

The APT, or System Package in Mint, is a *.deb file type.  The “deb” stands for a 

“Debian package” installation file and is used to install programs on a “Debian Linux” 
system, like what Mint is.  Essentially it is the same as a *.exe file in Windows.  

Updating a *.deb program depends on the program.  It might be wise to do an 

internet search on how to upgrade your specific *.deb program. 

 

For System Package (APTs) and Flatpak installed apps using the Software Manager, 

use the Update Manager app to check for updates.   
 

For AppImage installed apps usually from the app’s website; use a manual update 

procedure:  
 

If you want to update an AppImage without installing anything extra: 

1. Visit the App’s Website 

o Use your browser to go to the website where you originally downloaded the AppImage. 

2. Download the Latest Version 
o Save the new AppImage file to your preferred folder (e.g., ~/opt).  You may need to use 

the File Manager’s computer folder.  (refer to the Arduino’s installation instructions for 
details on moving to /opt.) 

3. Make It Executable 
o Right-click the new AppImage → Properties → Permissions tab → check “Allow 

executing file as program.” 

4. Replace the Old File 

• Delete or archive the older AppImage file. 

• If you had a menu shortcut, you may need to update it manually using Main Menu 

editor. (Or if the old shortcut does not work, delete it and create a new one.) 

 

Bonus Tip: Check for Built-in Updater 

• Some AppImage programs include their own update feature: 

• Open the app and look for an “Check for Updates” or “Update” option in the 

menu.  (Arduino IDE has its update check under the Help menu.) 
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8) Use Rescuezilla to backup the hard drive 

Rescuezilla is a backup & restore utility, commonly used in Linux systems including 

Mint.  This image can be used to restore the computer if there is an issue with this 

computer or to image other computers. 

 

Before making the backup, this is the time to copy your personal files into the Mint computer!   

➢ Two USB (32GB minimum) drives are needed.  Label them USB1 and USB2 

(If you don’t have two USB ports on your PC, refer to next page for alternatives.) 
➢ USB1 is used for running the Rescuezilla app.  USB2 used for storing the backup file. 

➢ The balenaEtcher app is used to make USB1 a bootable drive.   

 

First: Create a Rescuezilla “bootable” USB1 drive 

Tip: A Tutorial on Rescuezilla: https://www.youtube.com/watch?v=duF6EVc9tuc    

1. Make sure you are logged in with the Admin password. 

2. Download the Rescuezilla .ISO file from https://rescuezilla.com/.  Selecting the 

recommended latest stable version.  

3. Download Etcher for Linux (ZIP) from: https://etcher.balena.io/  

4. In the Downloads folder, right-click on the Etcher zip file and select Extract Here. 

(You may get an error extracting the files, just ignore that. 

5. Insert USB1.  Open the new balenaEtcher folder and double click on balena-

etcher file to launch it.  Now follow the instructions to Flash from File and locate 

and select the Rescuezilla ISO file.  Then select the USB1 as your target drive.  

Finally, select Finish.  This will make USB1 bootable so you can launch 

Rescuezilla to make your backup or restore operations. 

When the Flash is Completed, close the balenaEtcher program.  You may delete 

the two downloaded files from your Downloads folder.  Keep USB1 inserted. 

 

Second: Create a backup on USB2.  

1. Restart your computer into the USB Boot Menu. Select the USB drive. 

Rescuezilla launches.  Select start Rescuezilla; wait for the Welcome screen.  

2. Insert USB2, the target drive.   

3. Select Backup; to create an image from the hard drive to USB2:  

Step 1 – Select your computer’s drive; this is what will be backed up. 

Step 2 – Keep all selected partitions.  This is a full image backup. 

Step 3 -  Select the USB2 drive as your destination drive 

Steps 4→8 – This is a summary of what’s to happen.  If all is correct, select Next. 

4. Wait for the “Backup saved Successfully” message. Select Next when done.  

5. To close Rescuezilla properly, click on the small “Display” icon in the lower left-hand 

corner and select Shutdown.  Select Reboot.  After the reboot into normal Linux Mint,  

Use the Files app to “eject or unmount” all USB drives and save them for future use.  

(Note that USB1 may be labeled “writeable”.) 

https://www.youtube.com/watch?v=duF6EVc9tuc
https://rescuezilla.com/
https://etcher.balena.io/


Linux Mint Install Setup and Tips _ 9.8.2025.docx  Page 19 of 34 

 

 

 

Don’t have “two” USB ports on your computer, here are some options for using 

Rescuezilla with only one USB port: 

 

    Option 1: Use the “Load USB into RAM” Feature 

Rescuezilla has a RAM-loading option at boot: 

• When you boot from USB1, after selecting your language, choose “Load 
Rescuezilla into RAM”. 

• Once it’s fully loaded into memory, you can remove USB1 and plug in USB2 for 

the backup destination. 

• This works best if your system has at least 4GB of RAM, ideally more. 

 

    Option 2: Use a Powered USB Hub 

If RAM loading from Option1 isn’t viable: 
• Use a powered USB hub to connect both USB drives simultaneously. 

• This avoids power draw issues and gives you flexibility for future workflows too. 

 

       Option 3: Backup to Internal Drive (Temporarily) 

If you’re just trying to get the backup done: 
• Save the backup image to an internal drive partition. 

• Then reboot into Linux Mint and copy the image to USB2. 

• Not ideal for long-term storage, but it works in a pinch. 

 

      Option 4: Use Network Storage 

If you’ve got a NAS or another networked PC 

• NAS stands for Network Attached Storage device. 

• Rescuezilla supports saving backups over the network  

• You can back up to a shared folder and later transfer it to USB2. 

 

 

 

Restore a PC procedure – using a backup file created by Rescuezilla:  

If restoration is needed, boot from USB1 and launch Rescuezilla.   

Then insert USB2 and select Restore.  Then follow the prompts.  
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Appendix: 

Resources: Tutorials, Troubleshooting, & Support  

A Historical perspective of Linux Mint: 

Linux was developed in 1991 as a kernel for operating systems. Two years later, the 

Debian Project was founded with tools that run on the Linux kernel.  In 2004, Ubuntu 

was launched as a Debian distribution offering more tools.  In 2006, Linux Mint 

started; its Cinnamon version is based on Ubuntu and its LMDE (Linux Mint Debian 

Edition) is based on Debian. Linux is funded by contributions & corporate support.  

 

Tutorials: 

There are many Linux and Linux Mint YouTube tutorials available to you.  

• Mint Setup Complete Guide: https://youtu.be/U6nik3bPIGs?si=-KuN3hXZDLHOYnji  

• Mint’s feature playlist of videos: 

https://www.youtube.com/watch?v=kUC9RbrS0q0&list=PLrW4kXWyzgoKKLkdHTH8E5v_JboLeAITi  

• Linux Usage Playlist:  
https://youtube.com/playlist?list=PLjie1qS4xnWhsfRJ5nWL_6S7I-kKf49bf&si=R4CQUkr3Knh6ec-V  

• Other apps?  https://youtu.be/RTwOvogeEVs?si=MLamXyBlUnqDfHMa  

• Linux Gaming – Reddit:  https://www.reddit.com/u/Intelligent-Gaming/s/1FqCqP8Weg 

• Installing WineHQ (for Windows apps running in Linux) 
https://youtu.be/iQ1R9Uv5kgA?si=3-Gbwuox8gEscMge  

• Modernize the Mint interface  https://youtu.be/OwBKbuy7U8s?si=ir-in0QuXg--GD7J  

• Timeshift (system snapshot) tutorial: https://teejee2008.github.io/timeshift/  

• Explaining Computers: https://youtube.com/@explainingcomputers  

• Learn Linux TV: https://youtube.com/@learnlinuxtv 

• Learning Linux ebook: https://github.com/GitJit-max/learning-linux  

• Linux Journey: https://labex.io/linuxjourney  

 
Troubleshooting problems:  

• Do Internet searches or use your favorite AI Chatbot. 

• The above Tutorial links are also good troubleshooting sites..  

• Tech Support website: (Excellent learning or just browsing website.) 
https://www.virtualcuriosities.com/articles/4216/linux-faq-for-windows-users-and-linux-beginners 

• Nvidia Driver Tutorial https://www.virtualcuriosities.com/articles/1788/how-to-install-

nvidia-drivers-in-linux-mint 

• Driver issues in general don’t usually exist. Amazingly most drivers are 

imbedded in the Linux kernel and are even updated.  

 

  

https://youtu.be/U6nik3bPIGs?si=-KuN3hXZDLHOYnji
https://www.youtube.com/watch?v=kUC9RbrS0q0&list=PLrW4kXWyzgoKKLkdHTH8E5v_JboLeAITi
https://youtube.com/playlist?list=PLjie1qS4xnWhsfRJ5nWL_6S7I-kKf49bf&si=R4CQUkr3Knh6ec-V
https://youtu.be/RTwOvogeEVs?si=MLamXyBlUnqDfHMa
https://www.reddit.com/u/Intelligent-Gaming/s/1FqCqP8Weg
https://youtu.be/iQ1R9Uv5kgA?si=3-Gbwuox8gEscMge
https://youtu.be/OwBKbuy7U8s?si=ir-in0QuXg--GD7J
https://teejee2008.github.io/timeshift/
https://youtube.com/@learnlinuxtv?si=JaMnAO1QMS9H9SHE
https://github.com/GitJit-max/learning-linux
https://labex.io/linuxjourney
https://www.virtualcuriosities.com/articles/4216/linux-faq-for-windows-users-and-linux-beginners
https://www.virtualcuriosities.com/articles/1788/how-to-install-nvidia-drivers-in-linux-mint
https://www.virtualcuriosities.com/articles/1788/how-to-install-nvidia-drivers-in-linux-mint


Linux Mint Install Setup and Tips _ 9.8.2025.docx  Page 21 of 34 

 
 

Resource Hub:  

What’s happening with Mint?  Check out these websites: 

➢ Wikipedia (Better than I thought it would be.) https://en.wikipedia.org/wiki/Linux_Mint  

➢ 9to5 Linux News https://9to5linux.com/?s=Mint  

➢ Its Foss - Customize Desktop  https://itsfoss.com/customize-cinnamon-desktop/ 

➢ It’s Foss - Email Newsletter: https://itsfoss.com/newsletter  

➢ Easy Tips - How to do anything: https://easylinuxtipsproject.blogspot.com/p/1.html  

➢ Known issues: (click on Release Notes) https://linuxmint.com/download.php  

 

Official Linux Mint support  

➢ Linux Mint Forums: This is the most active and recommended place for technical 

assistance. It is a community of users and volunteers who answer questions on 

installation, software, hardware, and other topics.  
https://forums.linuxmint.com/ 

 

➢ Linux Mint Documentation: Before posting in the forums, check the official 

documentation on the Linux Mint website. The site provides a user guide, an 

installation guide, and a troubleshooting guide that can help you solve many 

common issues.  
https://www.linuxmint.com/documentation.php  

 

➢ Reddit (r/linuxmint): The Linux Mint subreddit is another active community where 

you can find support and discuss news and information related to the distribution.  
https://www.reddit.com/r/linuxmint/  

 

  

https://en.wikipedia.org/wiki/Linux_Mint
https://9to5linux.com/?s=Mint
https://itsfoss.com/customize-cinnamon-desktop/
https://itsfoss.com/newsletter
https://easylinuxtipsproject.blogspot.com/p/1.html
https://linuxmint.com/download.php
https://forums.linuxmint.com/
https://www.linuxmint.com/documentation.php
https://www.reddit.com/r/linuxmint/
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Tips for using Mint 

1) The “LM” Menu button, on the left side of the Panel, is launched by clicking the 
“Windows” key on your keyboard or mouse click on LM panel icon. 

2) Here is the Menu layout. Tip: Drag apps in and out of Favorites column at any time. 

 

 

 

 

 

 

 

 

 

 

 

 

3) An easy way to launch an app: Click the LM Menu button, then start typing the 
name of your app.  Once it shows up, you can select Enter. 

4) Schedule a Timeshift to create a restore point periodically.  This is a good 

troubleshooting feature in case you need to return to a “good” known point. 
5) Desktop shortcut, (known as a “Launcher file”) is created by using these methods: 

1. Rt-Click on an app, then select Add to desktop 

2. Select Ctrl + Shift then drag then drag the file to the desktop 

3. Rt-Click on an app and select Create a Launcher file 

6) Taking screenshots  
Using the PrtScr key (This is the Print Screen key, on your keyboard) 

• Full screen: PrtScr button, Active Window: Alt + PrtScr   

• Selected area – Shift + PrtScr 
Using the Screenshot app from the Menu. After screenshot is taken:  

• Use the Save button to save to the /Home/<username>/Pictures folder  

• Use the Copy to Clipboard button to paste directly into a program 

A better app is Flameshot. www.flameshot.org  

7)  Right-Click options – How to edit the list 
In System Settings, there is an Action button found in the Preferences group.  

When selected, you can manage the list, download new entries to the list or 

change the layout. 

8) Desklets & Applets (Desktop & Panel apps) 

“Desklets” are apps added directly to the desktop. 

“Applets” are apps added to the bottom right-side of the Panel.  (These can be 

managed in the System Settings program.)   

This website contains more Themes, Applets, Desklets, Actions and Extensions 

which you can install on your system. https://cinnamon-spices.linuxmint.com/  

Apps contained in the 

selected Category 

Category column 

Favorites column 

Search field 

Tool Tip of what’s selected 

http://www.flameshot.org/
https://cinnamon-spices.linuxmint.com/
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Here’s a pretty good tutorial on making changes to the panel: 
https://youtu.be/m0zV42OId3M?si=HYyZx9RieJgZ8QKk 

 

9) Become familiar with Terminal: 

The Terminal is a text command interface. Keep in mind that many terminal 

commands can be accomplished using the Mint interface windows.   

Tip: if you are researching something and it says to use a terminal command, 

try googling a Mint GUI equivalent. (GUI = graphic user interface)   
 

Terminal Tutorial: https://www.youtube.com/watch?v=1tEtKMhoBIg  

An Terminal command to try is neofetch. Simply open Terminal and type in neofetch, 

then hit Enter. (Note that terminal commands are lower-case.) This displays your 

computer system information.  Check out some of the Terminal commands in the 

attached Terminal Command Cheat Sheet, located in this Appendix. 

Have Command fun!? https://overthewire.org/wargames/bandit/  

 

10)  Username on the Panel  

Not only do you see who’s logged in but by clicking on it you have an easy way 
to launch system commands; System Settings, Switch Users, Log out and Power 
Off options. Here’s how to get the Username displayed on the Panel. 
 

• Right click on an open area on the Panel, select Applets. (This launches the 
Applets settings window.) 

• Scroll down the alphabetical list and highlight the User Applet; then click the + 
button to add the applet to the Mint system.  Then click on the Gear icon, lo-
cated on the right side. In the User Applet configuration windows, turn on the 
Display user name on panel selection. Close the Applet window.  

• Left click on the username in the Panel. (If nothing happens, reboot your PC.)  

• If you wish to move the username to the center of the panel; right-click on a blank 
area in the Panel; turn on the Panel edit mode. Drag the username applet to the 
center green rectangle in the center.  Turn Off to Exit Panel edit mode.  

• Troubleshooting: if clicking on icons don’t do anything, then you need to reboot. 
Use the Super key on the keyboard to launch the Menu; select Shut Down, 
then select Reboot. After you log back in, everything should work again.  

11)  Startup Application list:  
Open the System Settings > Startup Applications.  Do you really need them 
all?  (Tip: if you don’t recognize them, do an internet search to see if you can 
disable them or keep them in Startup.) 

12)  Change Cursor color:  
The default black with white border icon can be changed by downloading Ox-
ygen-cursor-theme app from the Software Manager.  Then go to System 
Settings >  Themes > Advanced settings button > Mouse Pointer.  Pick a new 
cursor, like oxy-yellow.  

https://youtu.be/m0zV42OId3M?si=HYyZx9RieJgZ8QKk
https://www.youtube.com/watch?v=1tEtKMhoBIg
https://overthewire.org/wargames/bandit/
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13)  Memory and Disk Usage! 

• Launch System Monitor > Resources tab 

• For Memory usage: In the Resources tab: Look under Memory and Swap to 
see usage and total system memory. 

• For Disk usage: In the File Systems tab: All disk partitions are shown.  Look un-
der the Directory column for the root directory (/).  There is the total and availa-
ble disk space.  Also, a bar graph is shown.   Another app to view the disk us-
age is the Disk Usage Analyzer app. 

 

Note: Notice that there are no Drive letters, like in Windows.  Drives are 
“mounted” in Linux not labeled. Run the Terminal command: lsblk to see the 
mounted location. 
 

14)  Control Update Notifications 
Apps and the operating system, Mint, do not coordinate their software updates, 

like Microsoft and Apple do. Apps are more independent in Linux. So, it may ap-

pear that every time you launch Mint, an update will be waiting for you.  You can 

control this by following these tips: 

1) Open the Update Manager > Edit > Preferences 

2) Options tab: turn on the two Interface on/off sliders, change to “days” op-
tions in the Auto-refresh group that suits your needs 

3) Automation tab: I would recommend settings some of these only after 

you have a high confidence in using Linux Mint.  It’s a learning experi-
ence to see what updates are coming in.  When you’re ready, you can set 
these automatic install settings.   
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Keyboard Shortcuts in Mint 

More shortcuts can be found at: https://cheatography.com/shakiestnerd/cheat-sheets/linux-mint-cinnamon/  

Power button Tap to open Shut Down window, then Enter to shutdown 

Esc Usually closes a dialog box 

Alt + Tab Cycle through open windows 

Alt + F2 Run Command window  (r command = reset Mint display 

Alt + F4 Close window 

Win + up arrow Maximize window 

Ctrl + Alt + Delete Switch Users and Log Out 

Ctrl + 2 fingers slide Zoom in/out  (or Scroll mouse wheel forward/backward) 

Backspace or 

Alt + Left Arrow 
Go Back to previous (The Backspace does alone sometimes) 

Alt + Ctrl + Backspace Try this if the computer locks up. It goes to the Login Screen. 

Ctrl + H Hide and unhide files in folders 

Superkey + D Minimize windows (Show DesktopJ 

Alt + Ctrl + T Opens Terminal    

Copy in Terminal = Ctrl + Shift + C 

Paste in Terminal = Ctr l+ Shift + V 

 

 

Comparison chart for APT, Flatpak and AppImage files 

 APT (.deb) Flatpak AppImage 

Installation 
Termain commands 

or Software Manager 

Software Manager 

or Flatpak install 

Just download, enable 

execution permission and 

run. No installation needed 

System 

Integration 

Deep system 

integration; config 

files stored in 

standard locations 

Isolated from 

system unless 

permissions 

granted 

Minimal integration; runs as 

a portable (standalone) app 

Updates 
Centralized with APT 

update  

Separate update 

system via Flatpak 

update 

Manual; no auto-updates 

unless using external tools 

  

https://cheatography.com/shakiestnerd/cheat-sheets/linux-mint-cinnamon/
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Uninstalling Apps:  

In many cases, you can use the Menu to locate the program you wish to remove, 

then right click on it to select uninstall.  Keep in mind that if there is a Desktop icon 

for that program, it may not automatically be deleted; so right-click on the icon to 

delete it manually. 

 

For APT and Flatpak installed apps, using Software Manager to uninstall them. 

Apps that were installed using Software Manager, which are the System 

Package APT and the Flatpak package installed apps can use Software Manager 

to remove, or delete them. 

1. Open Software Manager. 

2. Select the hamburger 3-line icon. 

3. Select the Show installed applications. 

4. Select the app you wish to uninstall. 

5. Select the Remove button.  (Select Continue in the Additional software will 

be removed window) 

6. If the desktop icon remains, you can right-click on it and select Delete or 
Move to Trash. 
 

For Applmage installed apps, use this “manual removal” process  

1. To delete an Applmage file, the process can be a bit complex than APT or 

Flatpak program.  (Keep in mind that apps installed using Software 

Manager’s install packages do not use Applmage.  They are deleted from 
the Software Manager.)   

2. Try this terminal command to delete an Applmage file from the /opt folder. 

3. sudo rm /opt/FILENAME  

4. (Replace FILENAME with the name of the Applmage including its file 

extension. So, from Files > /OPT folder, right-click on the file and select 

Properties.  Then copy the Name. Finally, paste it into Terminal.) 
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Windows app – or an Alternative  

• With Mint installed, Windows 10 is gone. You can now use alternative programs or 

figure out how to run equivalent Windows programs in Linux Mint…. Yes, it’s possible. 
o Staying with Microsoft Office, you can run it on Mint.  You need to use the “online” 

version of Microsoft Office. Go to https://www.office.com/ 

o The Office equivalent, LibreOffice is preinstalled with Linux Mint.   

o You can install Windows apps using Wine or Bottles apps.  But It’s a more complex 

topic than we will not discuss here. Do your research. Try these Wine Tutorial videos: 

▪ https://www.youtube.com/watch?v=pXnx-KUwAg0  

▪ https://youtu.be/pXnx-KUwAg0?si=SYwboVDuyl19Znpt 

o Website for Wine Terminal commands: https://wiki.winehq.org/Ubuntu  

o The Web Apps app can connect to URLs that you currently use. 

• This website suggests alternatives for your programs:  https://alternativeto.net/  

• This website can be a great resource for you to find equivalent programs: 
https://www.linux.com/training-tutorials/linux-migration-guide-finding-linux-equivalents-your-favorite-windows-programs/  

• Just “google” it!  Do some internet research.  You just might find a perfect solution. 
Here are some common Windows alternatives for use in Linux Mint: 

Windows Linux Mint  

Notepad Xed Text Editor 

Outlook Thunderbird (you can connect to Yahoo or Gmail accounts) 

Microsoft Office LibreOffice (default in Mint), or OnlyOffice 

Paint Pinta (The Drawing app offers more capabilities.) 
Paint.js.org (A paint website, no download requrired.) 

Video / Music / Games 
VNC (video & music)  Steam for Gaming 
https://itsfoss.com/non-violent-games-llinux/  
Clemintine app – music player 

PDF Viewers Document Viewr (Okular is a popular PDF viewer & presenter) 

Browsers Firefox (Use Web Apps to run web-based programs within a 
browser. e,g., Yahoo, Gmail, Apple Music, iCloud…) 

Task Manager System Monitor (Downlaod Mission Center for more info) 

Windows Security ClamAV (Refer to Tips document for security discussion) 

System Report Menu > System Reports > System Information 
Stacer app and the Terminal command: neofetch 

 File History and 

 SystemBackups 

Backup Tool (for file backup) 

Use RescueZilla (for full harddisk image backup) 

Adobe 

Adobe Premiere – DaVinci Resolve 

Adobe Photoshop – GIMP, Krita 

Adobe Acrobat Pro – PDFSam 

FreeCAD, LibreCAD 

Autodesk AutoCAD FreeCAD, LibreCAD 

Steaming apps Can be used in your browser instead of a download. 

  

https://www.office.com/
https://www.youtube.com/watch?v=pXnx-KUwAg0
https://youtu.be/pXnx-KUwAg0?si=SYwboVDuyl19Znpt
https://wiki.winehq.org/Ubuntu
https://alternativeto.net/
https://www.linux.com/training-tutorials/linux-migration-guide-finding-linux-equivalents-your-favorite-windows-programs/
https://itsfoss.com/non-violent-games-llinux/
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Web Apps app 

This method of taking a website (like YouTube, Outlook, or ChatGPT) and turning it into an 

app-like shortcut. That shortcut opens in its own window—no tabs, no browser distractions. It 

sits in your menu like other apps, and you can add it to the panel or desktop. 

 

What are Web Apps? 

Web apps are applications that run in a web browser, allowing users to access them 

without installation. They provide functionality like traditional desktop applications but 

are more flexible and accessible. 

Popular Examples of Web Apps 

Web App Description 

Google Docs An online word processor for creating and editing documents. 

Gmail A web-based email service for sending and receiving emails. 

Facebook A social media platform accessible through a web browser. 

Netflix A streaming service for movies and TV shows. 

Twitter A platform for sharing short messages and updates. 

 

Using Web App Manager in Linux Mint 

Linux Mint's Web App Manager allows users to convert websites into standalone 

applications. Here’s how to use it: 
1. Install Web App Manager: Download and install it from the Linux Mint blog. 

2. Create a Web App: 

o Open Web App Manager. 

o Click the “+” icon to add a new website. 
o Enter the URL and customize the app's name and icon. 

o Save the app, which will now appear in your system menu. 

3. Access and Manage: Launch the web app like any other application. You can 

pin it to your panel or desktop for quick access. 

This process enhances the user experience by providing a more app-like feel to web 

applications, making them easier to use on Linux Mint. 

 

 

Online Accounts app 

The Online Accounts app lets you connect to your Google, and Microsoft, accounts 

from  your Linux Mint system. Once connected, your email, calendar, contacts, and 

files from those services can automatically sync with Mint’s built-in apps.  This app 

uses the browser in Mint to connect to your other accounts.   
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What’s the difference between Online Accounts and Web Apps: 
➢ Use Online Accounts when you want your cloud data to work inside Mint’s apps. 

➢ Use Web Apps when you want quick access to websites without opening a browser. 

 

        Online Accounts vs. Web Apps in Linux Mint 

Feature    Online Accounts App   Web Apps App 

Purpose 
Integrates cloud services 

with system apps 

Turns websites into 

standalone desktop apps 

Examples Google Drive, Microsoft 365 Gmail, Outlook Web, Spotify 

System 

Integration 

Deep: syncs with Calendar, 

Files, Mail, etc. 

Shallow: opens in browser-like 

window 

Data Access Native access via Mint apps Web-based access only 

Offline Use 
Possible (e.g., 

email/calendar sync) 

Limited or none, depends on 

site 

Privacy Control You choose what to sync 
It depends on website’s own 
privacy settings 

Setup Complexity 
One-time login, then 

automatic sync 

Manual creation of each web 

app 
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Windows VM on Linux for Apple iTunes 

(I found this on the internet.  I have not tried it out, so let me know if you try it. Thanks Dan) 

Installing a Windows Virtual Machine on Linux Mint for iTunes Use 
This guide explains how to install a Windows virtual machine (VM) on Linux Mint using 

VirtualBox. The purpose is to run iTunes for tasks like full iPhone backups, restores, and 

iOS updates, which are not fully supported by Linux tools. 
 

Recommended Windows Version 
We recommend using Windows 10 (64-bit) for compatibility with iTunes and VirtualBox. 

Windows 10 remains stable, receives updates, and runs well in a virtual machine. You 

can use a legitimate ISO from Microsoft’s website. 
 

Prerequisites 
1.  A Linux Mint computer with at least 8 GB RAM and 40+ GB of free disk space 

2.  VirtualBox installed (can be installed via Software Manager or Synaptic) 

3.  Windows 10 ISO file (downloadable from Microsoft's official site) 

4.  iTunes installer for Windows (downloadable from Apple.com) 
 

Steps to Set Up the Windows VM 
1.  Open VirtualBox on your Linux Mint system. 

2.  Click 'New' to create a new virtual machine. 

3.  Enter a name (e.g., Windows 10), set the type to 'Microsoft Windows' and version to 

'Windows 10 (64-bit)'. 

4.  Allocate memory (RAM). Recommended: 4096 MB (4 GB) or more. 

5.  Create a virtual hard disk (at least 40 GB). Choose VDI and dynamically allocated. 

6.  After creation, go to Settings > Storage. Select the empty optical drive and load the 

Windows 10 ISO. 

7.  Start the VM and follow the Windows installation process. 

8.  Once Windows is installed, install Guest Additions (Devices > Insert Guest Additions 

CD Image). 

9.  Download and install iTunes from Apple’s website within the VM. 
10. Plug in your iPhone and allow USB passthrough to the VM (Devices > USB > Your 

iPhone). 

Tips and Notes 

• Enable USB 2.0/3.0 support in VirtualBox’s VM settings (install the Extension Pack if needed). 
• Make sure to 'Trust' the computer when prompted on your iPhone. 
• You can take snapshots of the VM to preserve working states. 
 

Conclusion 
By setting up Windows 10 in a virtual machine, you can access the full functionality of 

iTunes while keeping Linux Mint as your main operating system. This hybrid setup offers 

the best of both worlds. 
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Anti-Virus for Linux Systems 

In the Windows world, security and anti-virus software are all the rage. Why 

Windows and not Linux? Windows is an easy target since it’s the most popular 
Operating System in the world and there’s only one version of it. Linux has about 5% 
of the PC market and there are many distributions of Linux.   

 

So, what’s happening in the Linux world?   
• There really is no “one distribution” of Linux; there are many!  For example, If 

malware is written for Linux Mint, it may not work on Linux Zorin. 

• App stores, like Software Manager in Linux Mint, contain apps that have the proper 

verified package containers.  (Most Windows users don’t use the Microsoft Store to 
download apps, which is safer than website downloads. 

• The "open source" concept that Linux uses means that the code created is 

publicly auditable. So, vulnerabilities and backdoors are easier to spot and 

fixed collaboratively, before ever reaching the downloadable repository. 

ClamAV Antivirus install & operation: 

The ClamAV app is a “terminal-based” virus scanner most often used by Linux home 

users. The ClamTK app is a GIU interface for the ClamAV antivirus app, making it a 

lot easier to use.  

• ClamTK Installation:  

o Open Terminal. Then type in  sudo apt install clamtk 

o Type in your admin password, to perform the installation. 

• Try opening ClamTK from the Menu. It should launch. 

• Then in ClamTK > Settings: check all the options for maximum scan protection. 

(To learn what these options mean, you can take a snapshot of the Virus Scan-

ner window, then launch your AI chatbot, and paste in the screen capture and 

ask what all these options mean? 

• Click on Scan a directory; it defaults to the Home/username folder.  This is ok but 

for a full scan of your computer, back up to the root folder (looks like a small 

square with circle in it.  Then click OK to start the scan.  (If you do a full scan with 

all scan options, it can take a while.) 

• Add ClamTK to the Other category in the Menu: 

o Right-click on Menu icon, then select Edit Menu 

o Left-click on Other, then click New Item button 

o In the Launcher Properties,  

▪ In Name, type in ClamTK antivirus  

▪ In Command, type in clamtk   (note that all commands are lower case)  

▪ Click Ok, then Close the menu editor.  Open Menu > Other  

 It also allows a “Scan for threats…” option in the File manager app. To scan just one 
folder, right-click on it in the Files app  and scan its contents. 
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Password Managers: 

A browser’s Password Manager feature. (Firefox even uses a Master Password) 

Here are some more powerful Password Manager programs: 

Programs Type Highlights Ideal For 

Bitwarden Cloud  Open source Simplicity 

KeePassXC Offline Local vault  
Privacy-focused 
users,  

Buttercup Hybrid Simple UI Middle ground 

1Password Proprietary Linux app Advanced users 
 

 

 

Anti-Virus software: (If you decide to use one; here are some examples) 

Software Key Features Best For 

Bitdefender  Affordable pricing Comprehensive system check 

Avast  Excellent real-time file scanner-  File servers and dual-boot setups 

ClamAV Free and open source Basic home users 

 

 

For “over-security” conscious folks: here are some suggestions:  

* Keep the system up to date & turn on the Firewall. (Best advice to give anyone) 

* Run the Brave browser. If not Brave, run Firefox with "NoScript" mode. 

* Portscan your device from another machine: disable or secure services and firewall them 

* Use Tripwire, Apparmor, Selinux, etc.  (useful for advanced Linux server systems) 

* Scan untrusted binaries with ClamAV or some other AV software. 
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Terminal Command Cheat Sheet 

This is a quick-reference guide to common Terminal commands.   

Note: The command name SUDO is an abbreviation for Superuser Do.  

(It’s an administrator command used in Terminal.) 

 

Here’s a good website to learn Terminal commands for the beginner: 
https://linuxconfig.org/basic-linux-commands  

Want a game to learn commands? https://overthewire.org/wargames/bandit/  

 

    File and Folder Basics 

Task Command Notes 

User’s home director 
(shortcut symbol) 

~ (Tilde) 
cd ~ 

The Tilde is a shortcut to the 

user’s home directory: 

/home/username 

List files in a folder Ls Like `dir` in Windows 

List files with details ls -l The -l display details 

Go to a folder cd foldername Like `cd` in Windows 

Move back on folder cd ..  

Current folder pwd Print (display) Working 

Directory 

 

      System Info and Cleanup 

Task Command Notes 

Show system info in 

nice format 

neofetch If it’s not installed, you may need to 

run sudo apt install neofetch first 

Show disk usage df -h Shows storage in human-readable 

form 

Show RAM usage free -h How much memory is being used 

Clean up unused 

packages 

sudo apt 

autoremove 

Frees space from old dependencies 

Live Resource Monitor top Shows real-time CPU memory and 

process usage. 

Linux Distribution 

information 

cat /etc/os-

release 

Names for Mint and Ubuntu are 

displayed 

 

  

https://linuxconfig.org/basic-linux-commands
https://overthewire.org/wargames/bandit/
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Reinstalling Windows 10 (this removes Mint) 

If you wish to return to the Windows 10 Operating System, follow the process 

below. 

 

   Step-by-Step: Reinstalling Windows 10 

You will need to have a USB flash drive for this process. 

1. Download Windows 10 “Media Creation Tool” 

o Go to https://www.microsoft.com/software-download/windows10  

o Click “Download tool now” 

2.  Create a Bootable USB Installer 

o Run the Media Creation Tool on a Windows machine 

o Choose “Create installation media (USB flash drive)” 

o Select your language, edition, and architecture (64-bit is standard) 

o Plug in your USB and let the tool format and prepare it 

3.  Boot from the USB on Your Linux Mint Laptop 

o Insert the USB into your laptop 

o Restart and enter the boot menu (usually by pressing F12, Esc, or Del 

during startup) 

o Select the USB drive as the boot device 

4.  Install Windows 10 

o You will probably need the Key value from the original installation of 

Windows 10. (Refer to the first section of this document, “Obtain 

Windows 10 Key before Mint Installation”.) 

 

 

https://www.microsoft.com/software-download/windows10

